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Introduction

EPIC (Education Portal Information Center) is FAME'’s system for processing our Education
Program payments. Currently, the system processes the State of Maine Grant Program,
GEAR UP Scholarship Program, Robert C. Byrd Honors Program, and Educator’s for Maine
Program and Tuition Waiver Program. Within the next year, it is FAME'’s goal to process alll
the education programs through EPIC.

General Screen Design and Navigation
The pop-up blocker on your browser should be turned OFF for EPIC.

You can use your mouse and/or your keyboard to navigate within EPIC. Below is
information on how the keyboard can be used:

Data fields: use the Tab key to move through data fields
Next or Previous button: tab to the button and press Enter
Check box: press the spacebar to check or to uncheck a box
Radio buttons: use the upt and down+V arrows

Dropdown boxes: use the upt and down+V arrows

Icons are used throughout the system. Hover your mouse over the icon and a text
description will appear.

Session Time-outs — For security purposes, you will be logged out of EPIC after 20
minutes of system inactivity.

Login
To login, go to https://onlinedb.famemaine.com/epic and enter your Username and
Password. Click on “Login” to access the Main Menu.

You may be prompted to change your password the first time you login to EPIC and at any
time EPIC generates a temporary password for you.

Fraave

FIFANCERAUTHURTT LI ERATNE

Please identify yourself with a valid username and password.

User Mame: |

Password:

.. Login

Forgot your username or password?

To return to the main page of the FAME web =ite, click here.

Mote: This site is best viewed with Microsoft Internet Explorer 6+ or Firefox 2+ with at least 800 by
600 screen resolution. Privacy Statement
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Forgot Username or Password

If you have forgotten your username or password, you can request information using the
“Forgot your username or password” link.

PINLANGSE AT PRI TR HE

Login

Forgot Password
Please enter your User Name and click Go. You will be contacted by FAME
personnel to review your information.

User Name:

Forgot User Name
Please enter your First Name, Last Name and the email address on your FAME
user profile and click Go. You will be contacted by FAME personnel to review
vour infermation.

First Name:

Last Name:

Email:

To request your user name or a new password, enter the required information and click
HGOH.

A secure email will be sent to you within a few minutes. The email will be from
noreply@famemaine.com with the subject line of:

Secure Message from the Finance Authority of Maine (FAME)

To view the email, you must enter the secure emalil site. First time users will need to create
a user name and password to access your account. Future emails will require you to use
your secure password to enter the secure site. If you have forgotten your password to this
site, you have 2 options:

1. Click on the “Forgot your Password?” link and answer the two challenge questions
you previously set up.

2. Call FAME Customer Service to reset your password at 1-800-228-3734 option 1
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Main Menu

The Main Menu provides access to all the options available to the user. Access will be
based on system permissions established for each user. Permissions can be set within the
following parameters:

°  Full access to system functions
° Read Only access to system functions
° Access to all or specific programs managed within the system

P o AP f UF EALE

Search: Go 2010-2011 # All Programs 7 Financial Summary ¥ |Logout
. mEnu & og ry &) Help HiLog

T Hello, UMO - FAO - University of Maine [002053 ]
Home

44 Taskpad 4 Online Student @& Student

AP L Rosters
g Awvailable in future release (4, Search For Students
g}? View/Certify Student Rosters
g File Transfer ¢ Payments 4s System Options

Pl Send Roster File to FAME &? Frocess Fayments and Refunds 5 Change Your Password

5 FRequest Student Roster/Cumulative Flleé? iew Financial History

gz Fils Transfer Results History

There are three ways to navigate through the system;

1. Main Menu Screen — To use the main menu screen, click on the name of the
function you wish to perform.

2. Side Navigation Bar — Click on the Menu button to expand the side navigation bar
(Click the Menu button again to contract the bar).

3. Breadcrumbs — As you navigate through the system, links are displayed at the top of
each page that allows you to return home or back to the prior page. These links are
called breadcrumbs.

You can also return to the Main Menu page at any time by clicking on the FAME Logo.
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Breadcrumbs

iﬁhﬂ:_!.l'.!'l‘imﬂ-ﬂi TIAIH

Search: G0, 2000-2010 ¥ All Programs # Financial Summary ¥ i) Help ﬂ Logout

MENU

= =

Home > Search

Breadcrumbs, at the top of each page, follow the path from the Main Menu to your current
page. Click an underlined breadcrumb to link to a page along that path. Return to the Main
Menu from anywhere in EPIC by clicking the Home link in the left-hand corner of the page,
below the toolbar.

Menu Dropdown

— Search: | i...g& 2009-2010 + All Programs # Financial Summary ¥ g Help nLognnt
¥
&% Taskpad !
4§ Online Student Rosters  ~ 4 Online Student & Student
Rosters
@ View/Certify Student Rostars uture release Q Search For Students
@ View/Certify Student Rosters
& Student -

)l Search For Students

£ File Transfer v

r ¢ Payments & System Options
@ L gt File to FAME @ Process Payments and Refunds 2 Change Your Password
% System Options » lent Roster/Cumulative Fila@ View Financial History

Results History
.4 Change Your Password

Use the Menu Dropdown from any page within the system to move to a different EPIC
section. Click a heading name or the down arrow to expand the view. In the screen shot
above, Certification Roster and Student have been expanded to show the functions
available in those sections. Click the heading nhame or down arrow again to collapse the
view. Click Menu or the down arrow beneath it to close the menu.
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Quick Search

 FIRANCERUTHORIT FIUEFIATNE &

SENL Search: | smith, || 2009-2010 + All Programs # Financial Summary ¥ 1) Help ﬂ Logout
Ea

Use Quick Search to search for a student by: last name, first name, first and last name, or
Social Security Number (SSN). If searching by name, at a minimum, enter the first initial of
the student’s first and/or last name. If entering last name before the first name, the names,
or any portion of the names, must be separated by a comma. The more letters entered, the
more refined the search results will be. For example, entering C Clark or Clark,C will return
all students in the data base whose last name includes “Clark” (i.e., Clark, Clarke, Clarkson)
and whose first name begins with C. Entering Ch Clark or Clark,Ch will return only the
student(s) whose first name begins with Ch. If searching by SSN, you must enter the
complete number.

Clicking “Go” opens the Search Results screen (see the Full Search section for more
information).

Academic Year Selection

QG F

FNANCERUTHORITPOPHAINES

Search: Go 2010-2011%  All Programs ¥ Financial Summary * ¢ Helj | Logout
MENU [ St S @uelp I
. = Hello; UMO - FAD - University of Maine [002053 ]
2010-2011
Home
2009-2010
44 Taskpad 4§ Online Student & Student

; . Rosters -
g Awvailable in future release (Ll Search For Students

§& View/Certify Student Rosters

g File Transfer ¢ Payments i System Options

4 Send Roster File to FAME @ Process Payments and Refunds -} Change Your Password

g Request Student Roster/Cumulative FiIE@ View Financial History

g File Transfer Results History

The academic year you are currently working with is displayed. To switch to a different
year, click the academic year and select another year from the dropdown.
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Program Dropdown
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¢ Send Roster File to FAME

el File Transfer Results History

MENU Search: | | s 2009-2010 ¥ All Prog - Fi v v @Help  Hijlogout
All Programs
Home

Educators For Maine
Posthacc

@ Taskpad & Online € & Student

Rosters Educators For Maine
g Available in future release LLELEL ) search For Students
@ View/C

Gear Up
Robert €. Byrd
Program

g File Transfer ¢ Payments s System Options

@ Process Payments and Refunds ] Change Your Password

g Reguest Student Roster/Cumulative File@ ‘fiew Financial History

Users have the option to view all programs when performing functions or selecting an
individual program. Only programs that you have access to will be shown in this drop down
list. To work with an individual program, click the program name. You can switch between

programs or return to all programs at any time.
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Financial Summary

F

FINARCEAUTHURTEFCEA AL
Search: i Go 2000-2010 ¥ Al Prog » F ial Y @ Help  H]Logout
MENU
"
Home 2009-2010 All Programs
} Totals Amount Students
@ Taskpad &% Online Student R —— 2
. . Bictere varde $170,802.
g Awvailable in future release Certified £0.00 0
,@Q View/Certify Student Roste -
Pending Payment £0.00 0
Pending Refund $0.00 (3}
Disbursed $0.00 (2}
& File Transfer ¢ Payments
B Educators For Maine Postbacc
. Send Roster File to FAME 9) Process Payments and Refi
s Request Student Roster/Cumulative Fi\eg-;e iew Financial History fotals famant Shadent
. Avarded 0.00 o
g File Transfer Results History ssesies s
Certified 30.00 o
Pending Payment £0.00 o
Pending Refund 50.00 o
Disbursed $0.00 o
[ Educators For Maine Undergrad
@ CearUp
3 Robert C. Byrd Program

Click Financial Summary to view information on awards at your institution for the Academic
Year. The top portion of the dropdown is information for all programs or, if you have
selected a specific program in the Program dropdown, information specific to that program.

If you are viewing all programs, to view information specific to a program, click the plus sign
next to the program name to expand the view. Click the minus sign to collapse it. To view a
different academic year data, see Academic Year Selection.

Help Button

The “help button” will pop up a box allowing you to send your question to FAME. Note that
you can also find information on FAME’s program guidelines at the following link by
selecting EPIC Login from the left side menu:

http://lwww.famemaine.com/files/Pages/education/aid_administrators/FAME_Services.aspx

Logout
Click the Logout button, in the top navigation bar, to log out of EPIC.
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Task Pad

To Do Items

When implemented, your To Do Items will alert you to tasks such as requesting payment for
students who have been certified as eligible.

Search for Students

Enter search criteria in one or more fields. The more data entered, the more refined the
search. A student must meet all the criteria you enter in order to be selected.

Active Year: Search for student records in the academic year displayed on the top toolbar.
Search will default to Active Year.

All Years: Search for student records that meet your search criteria in any year in the
database.

Name: Enter all or a portion of the student’s Last Name, First Name and/or Middle Initial.
The search results will be more refined the more letters you enter and if you enter all or a
portion of both the first and last name.

SSN: Enter the full Social Security Number if using it as a search criterion.
DOB (Date of Birth): Enter using MM/DD/YYYY or MM/DD/YY format.

Address: City, State and Zip searches on a student’s permanent address.

-10 -



FAME EPIC FAO USER MANUAL

FINANCE AUTHORITY OF MAINE

Business & Education
at Work for Maine

Search Results — Quick Search and Full Search

Search: Go 2010-2011 = All Programs # Financial Summary # @) Help ﬂLngnut

- -~

MENU
~ » - - 3
L Hello, ABICKFORD - FAO - Miller University [888888 |

Edit Student > Home > Search for Student

Enter the student information you wish to search for in the box below, and click [Search] to locate that student.

Search Criteria

@ Active Year O Al Years

Last Name;: | ADANMS First Name: MI:
SSN: DOB:
City: state:| Al [ Zip:
.. Search

Search Results

Search Results - Found 3 students.

Student ID Last Name First Name Social Security Birth Date

67145 ADAMS AMY ###-##-3333 01/05/1990
32847 ADAMS ANDREW EEE-E#-4444 05/02/1991
89716 ADAMS JOHN EEE-#2-6666 04/01/1991

To =earch again, click here.

Select the student from the Search Results screen. If more than 100 students meet the
search criteria, the first 100 students will display. Refine your search by entering additional
criteria.

To refresh the Search Criteria screen, click the click here link at the bottom of the Search
Results screen.

-11 -
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Edit Student

All the student information in EPIC that is available to institutions is in the Edit Student
screens.

Click the plus sign on the bar to expand each section; click the minus sign to collapse it.

General Information

Search: Go 2010-2011 ¥ All Programs + Financial Summary ¥ Hel | Logout
MENU = Guelp
@ ~ :

Edit Student

ADAMS, JOHN B - ###-##-6660
FAME Student ID: 89716
E  General Information
Last Name: | ADANS First Name: | JOHN Middle Name:

GGM: | 444-35-5553 Birth Date: | 24011351 Dependency Status: | Dependent

Has Bachelor's Degree: | Mo

Year In School:

Resident Of State: | Msinz (From Application/FAFSA
Transaction #: |02 Transaction Date: | O484/2010 Receipt Date: [0V
EFC:  RESOR0 valid EFC: [ a2
Save

B  Academic Period Information

E Disbursement History

a Comments

Data in the general information section is populated initially from the most recent FAFSA
and/or a FAME program application.

The FAME student ID# is a unique ID number stored in the FAME database. You may
reference this number when contacting FAME regarding a student.

The editable fields with full access permissions are:

° Last Name
°  First Name
° Middle Name

-12 -
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Academic Period Information

Use Academic Period Information to view a student’s award eligibility by term and to certify
the student’s eligibility for those awards.

Click the plus sign next to the term to expand the view for that term.

The program(s) displayed in this section are a result of the program filter set in the program
drop down. Other factors may include the program(s) the user has access to, and programs

associated to the student.

ADAMS, JOHN B - ###-##-606606
FAME Student ID: 89716
a General Information

=] Academic Period Information

E  Fall of 2010-2011 Academic Year

a Spring of 2010-2011 Academic Year

EFC: Enrcliment Status: Year in School: M?klng EXPE.CtEd Qrad bate Last -T'\ttelndanse Date
SAP: (mm/yyyy): (mm/dd/yyyy):
520,401.00 1 = Full time D 2nd year/zophomore D Yes D
Status Certification / Adjustment reason Program Points Adj Award Awarded Paid
o O BYRD NJA £750.00 £0.00
Q O SMGP 0 £0.00 £0.00

Program Status Icons

Icons in the Status column provide a quick visual of the student’s status for each program.
See the screen shot to the left for a description of each status icon.

Program Status Details
JOHN ADAMS

A refund is not due for this student.
~ Student has not been paid.
Student has not been certified.
Student has been awarded.

Student has been selected for awarding.

Robert C. Byrd Program - Renewal
Student is eligible

0 09 2 Q

Student's application is complete.

Close

Program Status Details
JOHN ADAMS

¢ A refund is not due for this student.

Vi

Student has not been paid.
4 Student has not been certified.

Student has not been awarded.

» Student has not been selected for awarding.

i} Maine State Grant Program

Student is ineligible: EFC is greater then
the cutoff amount

NextGen Student Grant Program
Student is ineligible: EFC not within
eligible range

NextGen Access Student Grant
Student is ineligible: Does not meet EFC
Maximum requirements
Does not meet enrollment requirements

Q Student's application is complete.

... Close

X

-13 -

Hover your mouse
over the status icon
and the status will
display. Click the
icon to display the
Status Details popup
window shown to the
left. The status icons
shown in color
represent the
student’s current
status.
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With full access permissions changes can be made to the displayed fields at any time.

Changing or entering a value for any of the fields will activate the Save button.

Each field must be reviewed and updated, if applicable, when certifying a student’s

eligibility.

The fields that are editable with full access permissions are:

Field Label Available Actions/Selections
Will display most recent EFC from
FAFSA up to certification. EFC is
EFC displayed by term but is an academic

year value. Once certified, this field will
not update. A school, can update this
field at any time.

Enrollment Status

Full-time
Three-quarter-time
Half-time

Less than half-time
Not sure

Not enrolled

Year in School

1% year, never attended college
1% year, attended college before
2" year/sophomore

3" year/junior

4™ year/senior

5™ year/other undergraduate

1% year graduate/professional
Continuing graduate/professional

Making SAP
(Satisfactory Academic Progress)

Yes
No

Expected Graduation Date

Important for Loan based programs only.
Date the student is/has:

° Expected to graduate

°  Graduated

Last Attendance Date

Important for Loan based program only.
Date the student is/has:

°  Withdrawn
°  Enrolled LTHT

-14 -
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This column is used to certify award
eligibility for the student and allow award
adjustments.

To confirm award eligibility, check the
certification check box and click the save
button. This will certify that the current

Certification and Adjustment information is correct.

Reason

To adjust an award amount, click the "=
Icon to choose the adjustment reason.
This will activate the adjusted award
amount field.

Adjustment Reasons will vary based on
program.

Sum of points awarded by program. This

Points o . ; :
function is not available in this release.

Some programs will display additional
information. Example EFM will display
whether the promissory note has been
received.

Program Specific Fields

If the student is eligible for an amount
other than the amount shown, enter the
revised amount in the Adjusted Award
Adjusted Award field. If you are adjusting the award down
to -0- due to non enrollment, leave this
field blank and uncertify the student or
mark them not enrolled

Maximum amount the student is eligible

Awarded to receive or the adjusted down amount
entered by the school.

Paid Amount the student has been paid.

Save Button Activated once data is edited.

Note: All fields are term specific with the exception of EFC.

- 15 -
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Disbursement History

This section will display disbursements for this student. It will include any prior year
disbursements made to the school as well.

E  General Information

E  Academic Period Information

E Disbursement History

Institution Name Program Date Amount Term Status
Hussen University EFM - UG 10/08/2009 £1,500.00 Fall Disbursed
Hussen University EFM - UG 02/09/2010 %$1,500.00 Spring Disbursed
Hussen University SMGEE 06/01/2010 £625.00 Fall Disbursed
Hussen University SMGP 02/16/2010 £625.00 Spring Disbursed

a Comments

Comments

To enter a comment, click the Add New Comment button. Enter your comment in the text
box that opens and then click the Save Comment button. Comments you enter will only be
visible to users at your institution and FAME. Please note that FAME also has the ability to
enter comments.

In the comment table, the first characters of your comment will display (see below). To read
the full comment, click on the comment line and the full message will display in the text box.
A comment can be up to 512 characters in length.

a General Information

a Academic Period Information

] Disbursement History

=] Comments

Malke a selection from the list to display content in the box below.
Date Usar Comment Type Organization

9/16/2010 1:30:07 PM Alida Bickford Example Comment - use this area to note informatien that can be User 313837
sharad with FAME and other schoals,

Enter as many comments as needed

Save Comment

-16 -
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Certify Student Eligibility

You must certify an eligible student to request payment each term. There are three ways to
certify students:

1. Certify individual students online through Edit Student/Academic Period Information.
2. Certify a roster (a “list”) of students online.
3. Download the roster as a file, update the file, and upload the file to EPIC.

In addition to rosters of awarded students ready for certification, you can view and download
rosters of students based on their status for the term and update them as needed.

Certify a Roster Online

EPIC allows schools to choose the parameters for student certification by program, term,
and student status. The certify roster online screen will look and function the same as the
academic period information described in the Edit Student section of the manual.

1. Select View/Certify Student Rosters from the Online Student Rosters section of the
main menu.

2. When you first access this screen, you will be required to select a term. To set or
change the term(s) to view, click the Click here link.

FINANCERUT BUREE T AITATNE

Search: 2000-2010 ¥ All v @) Help BlLogout

Search for Student = Roster Selection

2009-2010 Academic Year - All Programs

» Academic Year: 2009-2010
» Selected Terms: Mo terms have been selected.
= All Programs

Srafest

\ 4

Click here to
Click on tha £

change your terms.
ter type to view and certify each student or "View and Print” for a PDF of the roster.

Click Link to View and

Select the type of roster you would like to work with. Print Roster

{} Awarded and Not Certified (0) View and Print
Students who are eligible to receive an award but not yet
certified.

@) Certified and Not Paid (0) View and Print
Students who are certified as eligible but have not been paid.

Q Paid (0) View and Print
Students who have been paid.

0 Refund Due (0) View and Print
Students for which a refund is due to FAME.

€3 Certified Ineligible (0) View and Print

Students who have been certified as ineligible.

-17 -
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3. View the following in the top portion of the roster selection screen:
e Academic Year — Academic year selected from top navigation bar.
e Selected Terms — Term(s) selected from the term pop-up box.
e Programs — Program(s) selected from the top navigation bar.

4. To set or change the term(s) to view, click the Click here link.

5. Click Awarded and Not Certified to view and certify your roster of students online.

6. Click Certified and Not Paid or Paid to view information, in roster format, for students
in those categories.

7. Click the View and Print link to view and print a roster. See the View and Print Roster
section for more information.

Once you have chosen a roster type to work with you will be directed to Certify Roster
Online screen. This screen allows you to verify and update information regarding the
student and their award/loan.

Search: Go 2010-2011 + All Programs ¥ Financial Summary + | Hel Logout
MENU guep &l
- —

Home > Roster Selection > Certify Roster

2010-2011 Academic Year - All Programs - Fall, Spring - Click here to change terms.
Roster Selected: Awarded and Not Certified
Page 1 i:i Next (expand all) (contract all) Select All Save All Changes
E ADAMS, AMY (###-##-3333) Total Awarded: $3,000.00 Total Paid: $0.00 [view student])
B Fall of 2010-2011 Academic Year
I Date + A n D
EFC: Enrcliment Status: Year in School: E)DE.CtEd Gr ad Date Last -:\ttelndal.ge Dt
(mm/yyyy): (mm/dd/yyyy):
S8.217.00 1= Full fime 3| | 3rd yearjunior [V
Status Certification / Adjustment reason Program Points Adj Award Awarded Paid
2 O (] EFM-UG| 4 |Educatdrs For Maine Master Pramissary Note Received $1,500.00 |$0.00
(X O L] SMGP 0 $0.00  s0.00
@  Spring of 2010-2011 Academic Year
£ ADAMS, ANDREW (###&-##-4444) Total Awarded: $1,500.00 Total Paid: $0.00 [(view student)
£ ADAMS, JOHN [###-#&-6666) Total Awarded: $1,500.00 Total Paid: $0.00 [view student)
£ BIRD, JAMES [###-##£-2245) Total Awarded: $32,000.00 Total Paid: $0.00 [view studant]

8. Expand the region for an individual student by clicking the plus sign next to the
student’s name.

9. To expand the regions for all students, click the (expand all) link. If you have
expanded one or more regions, click the (contract all) link to collapse all the
expanded regions.
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10. To certify all students displayed on the page you may click the (Select All) link. Once
you have selected all students as certified, click the Save All Changes button. Note it
may take a few minutes before all changes have been saved.

11. View more detailed information for a student by clicking the (view student) link at the
end of each bar.

View and Print a Roster

EPIC allows schools to choose the parameters to view and print a roster by program, term,
and student status.

1. Select View/Certify Student Rosters from the Online Student Rosters section of the
main menu.

2. When you first access this screen, you will be required to select a term. To set or
change the term(s) to view, click the Click here link.

FINANCERUTHORIT VO FIRRE

BENL - Search: Sy 2009-2010 ¥ All Programs # Financial Summary ¥ &) Help u Logout

B

Roster Selection

2009-2010 Academic Year - All Programs

» Academic Year: 2009-2010

» Selected Terms: Fall

» Programs: All Programs

Click here to change your terms.

Click on the roster type to view and certify each student or "View and Print" for a PDF of the roster.

Click Link to View and

Select the type of roster you would like to work with. Piint Rostar

{}) Awarded and Not Certified (36) View and Print
Students who are eligible to receive an award but not yet
certified.

@) Certified and Not Paid (0) View and Print
Students who are certified as eligible but have not been paid.

0 Paid (0) View and Print
Students who have been paid.

(@ Refund Due (0) View and Print
Students for which a refund is due to FAME.

€ Certified Ineligible (0) View and Print

Students who have been certified as ineligible.

3. Click the View and Print link to view and print a roster. Note an active link will only
appear if there are students in that roster type.
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EElx]

Roster Type: Eligible and not Certified
Academic Year: 2010-2011

Terms: Fall, Spring

Program: All Programs

Return to Certify Roster

Status Certified Last Name First Name

o ADAMS AMY

Q ADAMS AMY

(X ] ADAMS AMY

(X ] ADAMS AMY

Q ADAMS ANDREW
Q ADAMS ANDREW
(X ] ADAMS ANDREW
(x] ADAMS ANDREW
Q ADAMS JOHN

Q ADAMS JOHN

(X ] ADAMS JOHN

(X ] ADAMS IOHN

4] BIRD JAMES
Q BIRD JAMES

55N

EEE-2F-3333

##2-2#-3333
###-##-3333
F##-##-3333
gEE-E#-444d
grE-gE-4444

EEE-£E-4444

#EE-£E-0444

FE=-z=-0000

EEE-2Z-6666
EHEE-2#E-2345
EEE-FE-2345

Program

EFM - UG

EFM - UG

SMGP

SMGP

BYRD

BYRD

SMGP

SMGP

BYRD

BYRD

SMGP

SMGP

EFM - UGG

EFM - UG

Term

Fall
Spring
Fall
Spring
Fall
Spring
Fall
Spring
Fall
Spring
Fall
Spring
Fall

Spring

Amount Paid

$0.00
$0.00
$0.00
$0.00
£0.00
$0.00
£0.00
$0.00
$0.00
$0.00
$0.00
$0.00
$0.00

$0.00

[~]
Lo Print

Amount Awarded

$1,500.00
$1,500.00
$0.00
$0.00
£750.00
$750.00
£0.00
$0.00
$750.00
$750.00
$0.00
£0.00

$1,500.00

$1,500.00

4. Click the Print button to print this roster.

5. Click the “Return to Certify Roster” to leave this screen.
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Send Certification Roster File to FAME

EPIC offers the ability for any school to send batch files to certify students for most of the
programs managed within EPIC.

There are two methods for sending a certification file to FAME.

1. Request and download a roster file which will allow you to edit student data and

send the file to FAME for processing.

2. Create a file from your institution’s financial aid management system using the
specified file layout.

Request Student Roster File

To request a file for a specific program and term, Select Request Student Roster File from
the File Transfer section of the main menu.

MENU .
!

FINANCERTTHORTYIOTIRAINE

kaiB; 2000-2010 All Programs ¥  Financial Summary ¥ ) Help

Home > Roster Selection

ﬂ Logout

2009-2010 Academic Year - All Programs

» Academic Year: 200%-2010
» Frogram: &ll Programs

» Selected Terms: IND Terms Available vl

Please Choose a Program from the dropdown in the Top Navigation Bar.

Files Available for Download Request/Download

{} Awarded and Not Certified Request File
Students whao are eligible to receive an award but not yet certified.

@ Certified and Not Paid Request File
Students who are certified a= eligible but have not been paid.

G Paid Request File
Students who have been paid.

G‘ Refund Due Request File
Students for which a refund is due to FAME,

0 Certified Ineligible Request File

1. From the top navigation bar, select the program and term you wish to work with.

2. The top portion of the screen will display:

Academic Year — Academic year selected from top navigation bar.
Programs — Program(s) selected from the top navigation bar.
Selected Terms — Term(s) selected from the drop down box.
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3.

Select the type of roster you wish to request for download by clicking the Request
File link.

Your request will be processed and you will receive an email notification once the file
has been generated and is ready for download.

Search: Go 20009-2010 = Gear Up # Financial Summary ¥ &) Help ﬁJLugnut
- MENU
3 L

Home > Roster Selection

2009-2010 Academic Year - Gear Up

» Academic Year: 2009-2010
» Program: Gear Up

b Selected Terms: |Fa|| VI

Files Available for Download Request/Download
) Awarded and Not Certified File Ready

Students who are eligible to receive an award but not vet certified.

@ Certified and Not Paid Request File

Students who are certified as eligible but have not been paid.

& Paid Request File
Students who have been paid.

(@ Refund Due Request File
Students for which a refund is due to FAME.

G Certified Ineligible Request File
Students who have been certified as ineligible.

g Ineligible and Mot Certified Reguest File

Students who were determined by FAME as ineligible based on
program reguirements.

5.

6.

7.

Once you receive the email notification that your file has been processed, return to
the Roster Selection screen (click Request Student Roster File in the File Transfer
section of the main menu). Make sure the correct Academic Year and Program (top
toolbar) and Term are selected and display at the top of the screen.

Any generated files will show as File Ready in the request/download column.

Click on the File Ready link to open or save the file. Files are in .csv (Comma
Separated Value) format. These files can be opened through Microsoft Excel™ or a
similar software application. If you update the file, you must not change the layout,
use only valid values, and save the file in .csv format in order to upload it to EPIC.

In a .csv file:
e Each line of the file contains one record
o Each data value (i.e. column) is separated by a comma.
e The first row contains column headings.
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The following data is provided in this file. Fields are listed under two categories;
1. Fields that your institution can edit.
2. Fields that should not be edited.

Fields that can be edited:
a. Enroliment (Matches ISIR enrollment codes)
b. Yearin School
c. Dependency Status (Must be D or I)
d. EFC
e. Award Amount

Fields that should not be edited:
f. Last Name
g. First Name
h. Middle Initial
i. SSN (with dashes)
j. Date of Birth (YYYYMMDD)
k. Program Name
I.  Paid Indicator
m. Points Received (Payment points)

Send Certification Roster File to FAME

Files sent to the EPIC system must be for a specific program and term, follow the specified
file layout and be in .csv format. See the Certification Roster File Layout section for more
information.

NOTE: If you are a PowerFAIDS user, the State of Maine Grant Program file layout will
remain the same however, all downloaded files will be in the file layout described in the
Certification Roster File Layout Section.

To send a certification roster to FAME select Send Roster to FAME from the File Transfer
section of the main menu.
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- FINANCEATT AURTDROEHATNES - |

MENU Search: L Ba 2010-2011v  SMGP¥  Financial Summary ¥  (giHelp  f|Legout
Gl Hello, ABICKFORD - FAD - Miller University [885888 |

Home > Send File - Choose Upload Type

Steps to Send File

Program: State Of Maine Grant Program

Term Mame: Mot Szlectad

Transfer Method: n

File Name: r

O000®

Confirm Format: Not Cenfirmad

PR E|
2010-2011 - No Term Selected Tarm: | < Chocse One > (2|

No term selected. To choose a term, select it from the dropdown box above.
You must choose a Term from the drop down menu.
G Send a Test File to FAME

Send a test file to process 3 file without updating the FAME database. No information will be affected in the
FAME Secure Site.

Q) Send a Live File to FAME

Send a live file when vou feel comfortable that vour data is correct. The FAME database will be updated to
reflect the information that you send.

No files have been sent

1. The top portion of the screen outlines the steps to send a file:
Program — Select the Program from the top navigation bar
Terms Name — Select the Term from the drop down box
Transfer Method — Test or Live File

File Name — Name of file you are uploading

Confirm Format — Status of file format confirmation

2. To send a test file to the system prior to uploading live data, click Send a Test File to
FAME. This process allows you to walk through the steps of sending a file, including
confirmation of the file layout. It does not provide you with test response files or
update student data.

3. To send a live file, click Send a Live File to FAME.
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2010-2011 # SMGP #

| ise

Financial Summary ¥

@ Help

| Logout

Hello, ABICKFORD - FAD - Miller University [888888 ]

Home > Send File - Choose Upload Type > Send File - Find Your File

Steps to Send File

Program: State Of Maine Grant Program
Transfer Method: Livs Data
kot Szlzctaa

File Name:

Confirm Format: Mot Confirmed

Term Name: Fall
a
a

Send Student Information to AGENCY

Please locate the file to send:

Click on the [Browse] button below and locate the file you would like to
send. Once you select the file, click on the [Open] butten. Then click the

[Send] button.

| |[ Browse. | ]

Return to Main Menu

Send

4. Click the Browse button to locate the file you want to send. In the popup window,
find and click on the file, then click the Open button. If the correct file name appears
in the box on the screen, click the Send button. If the file is not correct, click Browse

again and locate the correct file.

Home > Send File - Choose Upload Type > Send File - Find Your File > Send File - Confirm File Format

COMNNERY

FORD

GREY

HOPE

PECK

PERRY

BOGART
CARSON

CLARK

JOHNSON
JONES
MARTIN

PETERS

Steps to Send File

Program:
Term Name:
Transfer Method:

File Name:
O

Confirm Format: Mot Confirmsd

File Format

JONNY
LISA
SHAWN
HARRISON
Joy
FAITH
LORI
JAKE
JANE
GREGORY
CALLEY
PETER

Live Data

999-12-1212

Stat= Of Main= Grant Pragram

888888-Fall-E-20100916(1).csv - 18 Records

Does the file format look correct?

As a precaution, you are reguired to confirm the file format of the file you just uploaded.
displayed.

Only the first 25 records will be

05/03/1988 3 3

sslancelfile.y
T e

999-45-4345 08/30/1931 1 1 D 1] 250 SMGP
888-35-2222| 12/08/1991 ¥ 1] D 1653 250 SMGP
891-22-8912| 12/28/1991 1 3 D a 250 SMGP
999-56-3656| 09/05/1992 - 1 D g24 250 sSMGe
432-11-4321| 03/16/1988 1 3 D 1] 250 SMGP
876-35-8765 03/08/1330 ¥ 3 o} (1] 250 SMGP
765-44-76354 | 06/07/1330 1 3 D aQ 250 sSMGe
777-88-995%  06/01/1992 & (1] D 1087 250 sSMGP
654-33-6543| 04/11/1991 1 2 D 200 250 SMGe
198-77-1987| 11/16/1989 ¥ 4 D 3114 250 SMGP
543-22-4532 08/04/1991 1 (1] D aQ 250 sSMGP
993-34-3434 07/22/1330 2 < 1 o068 125 SMGP

1 1] 125 SMGP
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5. Review the File Format to see how the system is reading your file. EPIC will alert you
if there are errors in the file layout.
If the layout is correct, click the Confirm File Format & Process Awards button.

6.
7. If there are errors, click the Cancel File button, resolve the file errors, and begin the
send file process again.
FNANCEAUTHORTY DT TIAE
ey Search: | | Eisal 2010-2011%  SMGPv  Financial Summary ¥ g Help  f]Logout
W Hello, ABICKFORD - FAO - Miller University 888388 |
Home > Send File - Choose Upload Type > Send File - Find Your File = Send File - Confirm File Format = Send File - Processing
Steps to Send File
E Program: State Of Maine Grant Program
Term Name: Fall
Transfer Method: Live Data
File Name: 588888-Fall-E-20100916{1),csv - 18 Records
Confirm Format: Confirmad
File Sent for Processing
Your file has been sent to FAME for processing. You will receive an email of the
status of your file when it completes. Thank you.
Return to Main Menu
8. Once you have submitted your file EPIC will confirm that the file has been received.

You will be notified by email once the file has been processed and the response files

are available for download.
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Download File Transfer Results
After a certification file has been processed, EPIC produces the following response files:

Eligible Students

Ineligible Students

All Students (not including exceptions)
Exception Records (students with invalid data)

You will receive an email alerting you that the response files are ready for download. Itis
important to review the response files in order to resolve any exceptions.

Select File Transfer Results History from the File Transfer section of the main menu.

FINANCERUTRURTTTGEHAINES
Search: Go 2010-2011 ¥ All Programs ¥ Financial Summary ¥ ) Hel Logout
_ menu 7 @Help ]

T g Hallo, ABICKFORD - FAD - Millar University [838888 |

Home > File Transfer Results

Download File Transfer Results

=] g 9/16/2010 2:02 PM 888888-Fall-E-20100916{1).csv Term: Fall Program: SMGP
g B88888-Eligible.csv - Eligible Students (18 students)
g 888888 Ineligible.csv - Ineligible Students (0 students)
p B888888-AllProcessed.csv - All Students (18 students)
p BB8B888-Exceptions.csv - Exceptions (0 students)

1. To download, click on the file name. Files are in .csv (Comma Separated Value)
format. These files can be opened through Microsoft Excel™ or a similar software
application.

Ineligible File: Two common reasons for a student to be in the Ineligible file are:
e Student indicated they have a prior BS degree.
e Student has an invalid EFC. If you are paying on an earlier transaction,
contact FAME to override the current invalid status and resend the student.
In most cases, this is a result of corrected ISIRs pending or that you are paying on
an earlier transaction. Our system loads all ISIR’s until a student is certified.

All Processed File:
This file will contain all the students you submitted except for any returned in the
Exceptions file.

Exceptions File:

This file includes students that FAME was unable to process if the name, social
security name and date of birth were not found. They must all be exactly the same
as our records. You can view what FAME has by searching for the student and if
needed making name changes.
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Request Payment

After certifying students online or receiving a response file of eligible students, the next step
is to request payment for the certified students.

To request payment select Process Payments and Refunds from the Payments section of
the main menu.

FINANCERUTHORNFOTFIATNE
e Search: b S0 2009-2010 ¥ All Programs # Financial Summary # 1§ Help _[J Logout
-

Tt

Home > Process Payments and Refunds

Process Payments and Refunds

Below is a list of the financial transactions that are ready to be processed or are pending. The "This
Transaction” column will indicate the status of the transaction.

Certified Awards Refunded Awards

™ Program Since Last Since Last Net Amount This Transaction bl
Transaction Transaction

[ | smep £118,446,00 £0.00 £118,446,00 Not Vet Requested | Datails

¥  erm-uG £3,000.00 £0.00 £3,000.00 Pending Details

[T | erm-uG £750.00 £0.00 £750.00 Panding Details

¥ | smep $12,000,00 $0.00 $12,000,00 Pending Details

1. Click the check box to the left of the transaction(s) you would like to process. The
check box for programs that are not available for processing are grayed out. To
select all programs, click the box in the header row of the table.

2. When you select one or more programs to process, the Process Selected
Transaction button will be activated. Click the button to submit the request.

3. To view the students and award amounts that make up a transaction, click Details in
View Details column.
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{=2=] gm  H =0 ZUO9=-IUIT AT Frogranis = FIancrat SOmimniary o nelp IE JTogooT

Process Payments and Refunds

e Confirm Payment Request Ll 1 This

You have selected the following to be processed:

Requested Payments e
v Program i, L ransaction E:‘:ils

Program  Amount T
M | smee SMGP $118,446.00 Lt Raqiiested: | Dotmls
I E Would you like to continue? ng Details
o = pfesy iuho [

=
I
I

Process Selected Transactions

4. You will receive a popup window asking you to confirm that you would like to
process the selected transactions. Click “Yes” to continue with the request or “No” to
cancel and return to the request payment screen.
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Financial History
The Financial History section allows you to view all financial transactions for your institution.

1. Click on the View Details link to view the details that make up this transaction.

2. You may select a specific program or year from the drop down in the top navigation
to filter the information viewed.

i Seardl [ | sl 2009-2010 *  All Programs ¥ Financial Summary ¥ @ Help  &lLogout

Home > Financial History

Financial History
Check Date Program Method Amount Type Details
10/02/200% Gear Up Check ($4,682.00) Refund View Details
10/02/2009 EFM - UG $3,000.00 Payment View Details
10/02/2009 EFM - UG Check ($3,000.00) Refund View Details
10/02/2009 SMGP $5,500.00 Payment View Details
10/02/2009 Gear Up $4,682.00 Payment View Details
10/02/2009 EFM - PB N/A $0.00 wash View Details
10/02/2009 SMGP $1,250.00 Payment View Details
10/02/2009 BYRD $1,500.00 Payment View Details
10/02/200% Gear Up $5,350.00 Payment View Details
10/02/2009 EFM - UG $3,000.00 Payment View Details
10/02/2009 EFM - UG $3,000.00 Payment View Details
10/02/2009 EFM - PB $2,000.00 Payment View Details
10/02/200% EFM - PB $2,000.00 Payment View Details
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Change Your Password

Your EPIC password is valid for 90 days. If you login to EPIC with a password that has
expired, the system will bring you to the Change Your Password screen. You must change
your password in order to continue.

You can also change your password at any time by selecting this option from the System
Options section of the Main Menu.

When changing your password, pay careful attention to the password requirements listed on
the screen.

Change Your Password

Pleaze change vour password below. Passwaords are case sensitive, please
check your "Caps Lock” key before continuing.

Password Requirements:

Password must contain at least 8§ characters.

Password must contain at least one number.

Password must contain at least one letter.

Password must contain at least one special character (!, @,%,%, stc.).
Paszswords expire after 90 days.

You cannot use your current or previous 5 passwords.

DQOQQRQ

Current Password:
Mew Password:
Confirm New Password:

Change Password Edl Cancel

=
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Send File Layout

Below is the file layout for transmission of certification files.

Note: If you are a PowerFAIDS user, the State of Maine Grant Program file layout will

remain the same however, all downloaded files will be in the file layout below.

Definition of certification roster file layout. File will be in a comma separated format. Each

column is defined below.

e Max length — Column may be of any length up to and including this value.
e Valid length — Column must be this length.

Field Name Comments Example
Last name Max length 30 Smith
First name Max length 30 Jane
Middle name Max length 30 M
SSN Valid length 9 123456789
Date of Birth YYYYMMDD, Valid length 8 19820521
Enroliment Status ISIR Standard or N for not enrolled, Max length | 1

1
Year in School (Grade ISIR Standard, Valid length 1 2
Level in College)
Dependency Status [,D, Valid length 1 D
EFC whole dollars, no decimal points, Max length 8 3500
Award Amount whole dollars, no decimal points, Max length 8 500
Program Name (optional, SMGP, EFM, etc, Max length 25 SMGP
can fill with spaces)
Paid Indicator P = Paid, <BLANK> = Not Paid P
Points Received Floating Point Number, up to 4 decimal places 2, 3.75, 8.3333
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